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Decontamination of medical 
devices 
 
A working group commissioned by the Scottish Executive Health 
Department (SEHD) undertook a review of decontamination 
practice in healthcare premises in Scotland ; it’s the first review 
of its kind in 40 years.  A team of trained assessors reviewed 
decontamination practice in 4 NHS hospitals, 1 private hospital, 
5 general medical and 5 general dental practices.  Whilst there 
were indications of good practice, most sites were deficient in a 
number of key areas. In some cases, practice was unacceptably 
poor. The SEHD has endorsed all the 14 recommendations made 
by the working group and in the NHS HDL (2001) 10 circular it 
has identified what immediate and medium-term actions are 
required.  Full details of the recommendations can be found in 
the report: The Decontamination of Surgical Instruments and 
Other Medical Devices (1 February 2001) 
www.show.scot.nhs.uk/sehd  

 
Healthcare-Associated Infection in 
NHSScotland  
 
In this context, SEHD set up a working group in November 2000 
to produce guidance for NHSScotland on assessing and managing 
risks related to healthcare-associated infection (HAI), 
decontamination and hospital cleanliness. 
 
The Group divided its work into the following three main tasks:  
 
• producing guidance on risk-management processes related 

to HAI 
• producing draft standards for infection control, 

decontamination of re-usable medical devices and cleaning 
services. 

• making recommendations on arrangements, at local and 
national level, for monitoring risks, setting standards and 
ensuring and reporting on compliance with the standards.  
The Group worked closely with the Clinical Standards Board 
for Scotland (CSBS), which has been charged with 
responsibility for developing a framework for national 
implementation. 

 
It is therefore recommended that the following SEHD reports 
be read in conjunction with the above summary: 
 
• The Decontamination of Surgical Instruments and Other 

Medical Devices (01 February 2001)  
 

 
 
• Report of a Joint Scottish Executive Health Department 

and NHSScotland Working Group:  
Managing the Risk of Healthcare Associated Infection in 
NHSScotland 

 
• Healthcare Associated Infections Review of 

Decontamination Services and Provision Across 
NHSScotland : NHS HDL (2001) 66 

 
• Decontamination of Medical Devices  : NHS HDL (2001) 10 
 
 
All the above reports can be obtained by accessing the Scottish 
Executive Health Department website:  
http/www.show.scot.nhs.uk.  The Greater Glasgow Primary Care 
NHS Trust Prevention & Control of Infection Team can be 
contacted on 0141 211 3568 if clarification or further discussion 
is required. 
 

Notifiable and reportable 
diseases 
 
The PHPU takes this opportunity to remind GPs of the statutory 
requirement to notify the Health Board of 'notifiable' diseases 
and to voluntarily report other specified infections. If you are 
unsure about these reportable and notifiable diseases then 
please contact our department (0141 201 4917) for a full list.  
 
Where a clinical diagnosis of measles, mumps or rubella is made, 
we would encourage GPs to obtain saliva samples from affected 
cases. The PHPU offers saliva-testing kits to all doctors who 
report clinical cases of these childhood infections (samples are 
sent to PHLS, London). Laboratory testing helps us to establish 
the true vaccine-failure rate in the population.     
     

BCG vaccine and primary 
immunisation 
 
We continue to receive enquiries about the time-interval 
required between BCG vaccine and primary immunisation. In the 
'Green Book', it clearly states that, "BCG need not delay 
primary childhood immunisations even though they include live 
polio vaccine". (Ref : Immunisation Against Infectious Disease 
1996, p224: 32.4.2) 
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Men C for 20-24 
year olds  
 
In 1999, the Group C conjugate 
meningococcal vaccine (Men C) was made 
available to all under-18 year olds. This 
campaign has seen a substantial reduction 
in disease in those children and young 
people (all now under 20 years) who were 
offered the vaccine.  
 
The Joint Committee on Vaccination and 
Immunisation (JCVI) has reviewed the 
epidemiology of Group C infection in the over-20 year olds and 
recommends that immunisation be made available to people up to 
the age of 24 years. The risk of meningococcal disease in the 
20-24 year old group is more than twice as high as the 
background rate in the over-24 year old group.  
 
Even if an individual in this age group has already received the 
polysaccharide vaccine, they should still receive conjugate Men C 
vaccine provided three years have elapsed. GPs can claim an 
IoS fee for immunising all unimmunised persons aged up to, 
and including, 24 year olds. For this group (20-24 year olds), 
they should use a multi-claim form and write at the top 'Men C 
vaccination 20-24 year old'.  
 
Additional stocks of leaflets and other publicity material can be 
obtained from our Health Promotion Department. 
 

Meningococcal disease and 
healthcare workers  
       
Antibiotic prophylaxis is given to close contacts of index cases in 
an attempt to reduce the risk of further cases of the disease 
within the household. The overall risk is small, but is greater for 
those living in the same household of the case than for the 
general population.  
  
In our experience, when a case of suspected meningococcal 
disease is notified, the question of antibiotic prophylaxis for 
healthcare workers who have had contact with the case often 
arises.  
 
Public health departments advise that only those healthcare 
workers who have been involved in direct mouth-to-mouth 
resuscitation of a suspected case of meningococcal disease or 
have been involved in a procedure that has exposed them to 
splashing with the case's oropharyngeal secretions should 
receive antibiotics. All other healthcare workers who do not fall 
into these two specific categories do not require prophylactic 
antibiotics.  
 

Hand hygiene  
 
Recent outbreaks of small round structured virus (SRSV) in local 
hospitals remind us of the importance of hand hygiene in the 
clinical setting. All healthcare staff should understand the 
principles of hand hygiene and be familiar with hand-
decontamination procedures.  Please note that there is a self-
directed learning presentation on our website. It consists of 50 
slides and includes a questionnaire to be completed at the end of 
the presentation.  

MMR : drop in immunisation 
uptake  
 
There has been a 7.5% drop in the MMR-uptake rate in Glasgow 
in the 2nd quarter of 2001 compared to the same quarter in 2000 
(see below). Unless this decline in vaccine-uptake is reversed, 
there is a real risk of a measles outbreak in the near future.  
 
3 month period/year       MMR-uptake rate  
 
Apr - June  2000 

        
       92.6% 

July - Sept 2000        93% 
Oct - Dec   2000        91.8% 
Jan - Mar   2001        89.4% 
Apr - June 2001        85.1% 
 
In December 2001, the Medical Research Council (MRC) 
published a review of autism research. The review was carried 
out to; take the broadest view of the causes of autism; consider 
whether Autistic Spectrum Disorder (ASD) has increased; and 
identify priority areas for research.  In relation to the MMR 
vaccine, the review concluded that "current evidence supports 
there being no link between MMR and ASD and is consistent 
with the findings of previous expert groups' conclusions 
published in 1998". www.mrc.ac.uk/PDFs/autism 
   
  
An article published last month in the American journal, 
*Pediatrics, addressed parents' concerns that multiple vaccines 
might overwhelm or weaken an infant's immune system. The 
authors concluded that current studies did not support the 
hypothesis that multiple vaccines overwhelm, weaken or 'use up' 
the immune system. Their view is that young infants have an 
enormous capacity to respond to multiple vaccines as well as to 
the many other challenges present in the environment.  
 
They go on to state that, based on their calculations, each infant 
would have the "theoretical capacity to respond to about 10,000 
vaccines at any one time" and is not at risk from the current 
practice of giving combinations such as measles, mumps and 
rubella. By providing protection against a number of bacterial 
and viral pathogens, vaccines prevent the "weakening" of the 
immune system and consequent secondary bacterial infections 
occasionally caused by natural infection.  
 
Children are, in fact, exposed to fewer antigens in vaccines 
today than they were in the past. The old smallpox vaccine, no 
longer given, contained about 200 proteins. The 11 childhood 
vaccines given in the US contain fewer than 130 proteins in total.  
In the UK, only 9 childhood vaccines are given with even lower 
protein numbers. *Pediatrics,Vol.109, No.1, Jan 2002 pp.124-129  
http://www.pediatrics.org/ugi/content/abstract 
 
The Public Health Protection Unit has the MMR discussion pack 
available in Braille and in audio cassettes. Please contact the unit 
if you would like to borrow them.   
 

ACT-HIB DTP vaccine 
 
Please note that during the month of February, the Scottish 
Executive has recommended that ACT-HIB DTPw (i.e. whole cell 
pertussis) vaccine be used for primary immunisation regardless 
of the preparation used previously. The Principal Pharmacist, 
PCT, faxed this information to all practices on 23/01/02. 
  

http://www.mrc.ac.uk/PDFs/autism
http://www.pediatrics.org/ugi/content/abstract
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This sidebar article was created with a text box. You can use 
a sidebar article for any information you want to keep 
separate from other articles or information that highlights an 
article next to it. These could include a list of contributors, 
addresses or contact information, a smaller self-contained 
story, a preview of the next issue, or a calendar of schedule. 
The example below shows a Calendar of Events. 

C A L E N D A R  O F  E V E N T S  
SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here. 

SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here.  

SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here.  

SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here. 

Template 
Type your sub-heading here 

Your By-line 
Your Company Name 

To keep these instructions, choose Print from the File 
menu. Press Enter to print the template. Replace the 
sample text with your own text to create your 
newsletter. 

Using Styles in This Template 
To change the Style of any paragraph, select the text 
by positioning your cursor anywhere in the paragraph. 
Select a Style from the drop-down Style list at the top-
left of your screen. Press Enter to accept your choice. 

 

See Page 4 to learn how to edit or replace this picture. 

The styles available in this template allow you to 
change the look of your headlines and other text. The 
following is a list of some common styles and their 
uses. 

Body Text - Use this style for the regular text of an 
article. 

Byline - Use this style for the name of the author of an 
article. 

Byline Company - Use this style to type the author’s 
company. 

SIDEBAR HEAD - Use this style to type a second-level 
heading in a sidebar article. 

SIDEBAR SUBHEAD - Use this style to type a third-level 
heading in a sidebar article. 

Sidebar Text - Use this style to type the text in a 
sidebar article



 
 
 M O R E  W A Y S  T O  C U S T O M I Z E  T H I S  
T E M P L A T E  

Inserting and Editing 
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Return Address 
Street Number and Name 
City, State  98765-4321 
 

 BULK RATE 

US POSTAGE 

PAID 

PERMIT NO. 

98765 

  
ADDRESS CORRECTION REQUESTED Mailing Address 

Street Number and Name 
City, State  98765-4321 

 
 
 
 

FOOTERS 

To change the text at the very bottom of each page of your 
newsletter, click Headers and Footers on the View menu. 
Use the Header and Footer toolbar to open the footer, and 
replace the sample text with your own text. 

INSERT SYMBOL 

It is a good idea to place a small symbol at the end of each 
article to let the reader know that the article is finished and 
will not continue onto another page. Position your cursor at 
the end of the article, click Symbol on the Insert menu, 
choose the symbol you want, and then click Insert. 

BORDERS 

You can use page borders and text box borders to change 
the appearance of your newsletter. Borders on text boxes 
help keep different articles separate, and can set off sidebar 
articles from the rest of the page. To change a text box 
border, select it, double click its edge and choose the Colors 
and Lines tab in the Format Auto Shape dialog box. 

Pictures 
Type your sub-heading here 

You can replace the pictures in this template with your 
company’s art. Select the picture you want to replace, 
point to Picture in the Insert menu, and click From File. 
Choose a new picture and then click Insert. Select the 
Link to File box if you don’t want to embed the art in 
the newsletter. This is a good idea if you need to 
minimize your file size; embedding a picture adds 
significantly to the size of the file. 

To edit a picture, click on it to activate the Picture 
toolbar. You can use this toolbar to adjust brightness 
and contrast,  

Choose a new picture, and click the Link to File 
box if you don’t want to save the art with the 

newsletter. 

change line properties and crop the image. For more 
detailed editing, double-click on the graphic to activate 
the drawing layer. " 
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